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STL Tones proudly presents Tonality: Wes Borland.

This exclusive guitar plugin suite has been developed in collaboration with Wes Borland, capturing the sonic and
visual anarchy for which Wes Borland of Limp Bizkit has become so distinctly renowned.

Using the most advanced hardware modeling algorithms, our software uses internal circuit tracing from the
schematics of the amplifiers Wes Borland uses playing live and in the studio, as well as his favorite overdrive pedals,
effects, and personal guitar cabinets.
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Tonality: Wes Borland comes in 64-bit VST3, VST2, AU, AAX, and standalone plugin formats.

Latest OS Compatibility for Windows & Mac, including Native Apple Silicon

Minimum Requirements Mac OS 10.13 or Windows 7

STL Licensing System, no iLok account required.

3 activations are available per user.

NOTE: During recording or monitoring, we recommend a buffer size of 128 samples or lower. This low buffer size is to
minimize latency and improve the play-through experience. This can be set in your audio interface setup utility or your
DAW audio settings.
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Tonality: Wes Borland is available in the following plugin formats, compatible with the noted Digital Audio Workstation
(DAW) platforms:

- VSTS3, VST2 (Cubase, Studio One, Ableton Live, and Reaper)
- AU (Logic, Garage Band, and Luna)
- AAX (ProTools)

Tonality: Wes Borland software can also be used as a standalone application. The Standalone version is perfect for
practice on the go and for use in live situations.
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- Always use the high impedance (Hi-Z) input of your interface. This will ensure less noise and signal loss. Most
analog (pre)amplifiers and stomp boxes have an input impedance of 1MegaOhm, so the best practice would be to
match the 1MegaOhm input impedance on your interface when using this plugin.

- Always make sure to have the highest input signal before the AD conversion, avoiding clipping.

- Amp and stomp box simulators are not noisy, they do not add noise. They’re a lot less noisy than analog hardware.
If you have noise issues, check your guitar’s electronic circuit, cables, and sound-card settings.

« In almost all cases, amp and stomp box simulators do not introduce noticeable latency. Tonality: Wes Borland
doesn’t introduce any noticeable latency. If you’re experiencing latency issues, check your interface settings.
Experiment with your input buffer size. We recommend a setting of 128 samples.
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STL Tones Download Center

Please visit hitps://www.stltones.com/pages/file-downloads where you will find the latest installers for your product.
STL Tones License System

 Your Activation License code will be in the confirmation email you received after your purchase.

« To login into your user account, go to www.stltones.com and click on the “Login” icon in the upper right-hand corner.
If you don’t have a user account, create one by clicking “Create Account” inside the same login window.

« Multiple Machines: Each activation code can be used on up to 3 different machines, however, the associated email
will always be the email entered during your first activation. If you try to activate the same code on a 2nd machine
with a separate email, the activation will fail.

« Trial Limitations: Only one trial can be requested per account or machine.

« The activation process is similar for trials and full licenses and is laid out below.


https://www.stltones.com/pages/file-downloads
http://www.stltones.com
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Full Perpetual License (Online Activation)

Access your account

Login using your STL Tones account credentials

Email

]

Password

« When you first open the plugin, you will be prompted to log in to your STL Tones user account.
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Register your device o

This is the first time you attempt to login from this device.

In order to verify your identity, we'll send a Verification Code to your
account E-Mail address.

Enter it below and click "Verify" to register this device.

If you don't receive a Verification Code within 2 minutes, check your
spam folder.

Verification Code

Format: xxxxxx

-a»

+ You will receive an email to the address you provided from activations@stltones.com. This email contains your 6-
digit verification code. Copy this 6-digit code from your email and paste it into the Verification Code field in the
menu, then click “Verify”. Note: Check your spam folder if you didn’t receive a verification code.



Installation and License Activation

Page 11

Activate your Product o0

We couldn't find a valid license for this product on this computer.

If you have purchased a license, you can activate it by clicking on
"Activate Product" and following the instructions.

If you don't have a license and want to trial the software, you can click
on "Activate Trial" to start your trial period.

Activate Product Activate Trial

Powered by Spirionix Signed in as: st

+ You then will be prompted to activate a license. Select “Activate Product”.
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© Activate your product (]

Please enter the Activation Code we sent to your account Email
address after your purchase to activate your product and click
"Activate”.

If you haven't received an Activation Code, check your spam folder.

Activation Code

[R5t el S e S0 S P e e S0 A |

Format: XXxXX=XXXX=XXXX=XXXX=XXXX=XXXX=XXXX=XXXX=XXXX=XXXX=XXXX=XXXX

-

- This will take you to the activation screen. Enter your activation code and click “Activate”.

Activated

Your product is now activated on this computer.

You can activate this product on 2 additional machines.
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Access your account

Login using your STL Tones account credentials

Emaiil

]

Password

« When you first open the plugin, you will be prompted to log in to your STL Tones user account.



Installation and License Activation

Page 14

Register your device

This is the first time you attempt to login from this device.

In order to verify your identity, we'll send a Verification Code to your
account E-Mail address.

Enter it below and click "Verify" to register this device.

If you don't receive a Verification Code within 2 minutes, check your
spam folder.

Verification Code

Format: xxxxxx

=D

+ You will receive an email to the address you provided from activations @stltones.com. This email contains your 6-
digit verification code. Copy this 6-digit code from your email and paste it into the Verification Code field in the
menu, then click “Verify”. Note: Check your spam folder if you didn’t receive a verification code.
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Activate your Product o0

We couldn't find a valid license for this product on this computer.

If you have purchased a license, you can activate it by clicking on
"Activate Product” and following the instructions.

If you don't have a license and want to trial the software, you can click
on "Activate Trial" to start your trial period.

Activate Product Activate Trial

Powered by Sp ix Signed in as: s e

+ You then will be prompted to activate a license. Select “Activate Trial”.
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© Activate your trial o

If you haven't evaluated this product yet, you can start your trial period
by clicking on "Activate Trial".

When in Trial mode, the product will be fully functional for the whole

trial period.
Activate Trial

- Select “Activate Trial”.

Activated

Your trial is now activated on this computer.

‘ Done




Main Interface Page 17

Input and Output Controls

The Input control affects how much signal the plugin receives. This will affect the distortion range of the gain pots in
the Amplifier and Stomp Sections. Adjust according to your purposes and input signal levels. The Output will affect
how much signal the plugin sends out to your DAW channel. The meters will show if input or output signals are
clipping by appearing red. NOTE: To make the virtual circuits react naturally to your guitar playing, it is vital to use the
correct signal level, so we suggest using the input Level Listener feature located top-right of the input knob.

@ ©® 5 - (")

INPUT GATE TUNER STOMP BOXES AMPLIFIER CABINET EFFECTS MIDI OUTPUT

Input Level Listener

X Input Level Listener

1. Select your pickup type

= 2. Set your guitar volume potentiometer to max = =

3. Adjust your soundcard input level to peak around -6dB

CHANNEL-1 e e
4. Play a few chords (5-10 seconds), the software will
TREBLE TY
automatically adjust the Input Level for best performances TO NALI AMP 1
POWER

= o)z =

Borland & o

PICKUP TYPE

[ Medium Output v]
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The Input Level Listener will assist in setting the plugin input level correctly.

The preamp level on your sound card needs to be set correctly for the Input Level Listener to work as intended. It is
advised to leave around 6dB of headroom on the A/D converter. In most cases, your sound-card input meters should
peak below the "yellow" zone while playing normally. If the sound-card meters LEDs are mostly yellow or red
(clipping), turn the preamp level down until you're in the "green" zone.

Once you open the Input Level Listener panel, the plugin analyzes your input signal and adjusts the Input Level
control accordingly.

Once your input signal is set correctly, select the Pickup Type from the menu:

- Low Output is for single coil or vintage pickups with low sensitivity.
- Medium Output is for passive humbuckers with balanced output.
- High Output is for active or hot passive humbuckers.

Start playing and the software will adjust the input level according to your guitar signal and the selected Pickup Type.

Here are some reference values you should see in the Input Level Listener if you've set everything correctly. If you
see values that are extremely different from the reference levels, please adjust the sound-card preamp and repeat the
process:

- Low Output pickup: Input Level in the -6dB to -3dB range.
- Medium Output pickup: Input Level in the 0dB to +3dB range.
- High Output pickup: Input Level in the +6dB to +9dB range.



Main Interface Page 19

Gate: Cuts unwanted noise spill, hiss, or hum by setting a threshold at which the input signal needs to be above for
processing.

Tuner: Click to open the Tuner. The tuning indicator light will span from left to right and turn green when the note is in
tune (middle position). When using the Tuner, you can switch off the output sound of the plugin for convenience by
clicking the speaker icon button on the bottom left side of the window. If you want to change the master tuning
frequency to something other than 440Hz, you can do so by clicking on the reference text box on the bottom right
side of the window. NOTE: Tuner runs in a modal window, so all the other controls in Tonality: Wes Borland are
disabled until you close the Tuner window.

| TONALITY AMP
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Stomp Boxes

1. Mini Filter: Inspired by the Electro-Harmonix© Mini Q-Tron™, the Wes Borland Mini Filter is an envelope filter
emulating the popular crying wah-wah effect.

2. Big Wezz: Based on the Electro-Harmonix© Big Muff Pi™, the Wes Borland ‘Big Wezz’ is a circuit-modeled
emulation of the iconic fuzz pedal, known for its crushing distortion and rich sustain.
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Amplifier: Select between the three available amp models.
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Cabinet Section: Click to open the Cabinet view. Here you can change cabinet, speaker, and microphone models.
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You can move the microphone around the speaker with 4 degrees of freedom: X (horizontal axis), Y (vertical axis), Z
(distance), and W (angle). Wes Borland’s cabinet speakers from his live touring rig have been measured with five
different microphones in more than 156 positions to achieve the ultimate realism and accuracy. You can further tweak
your tone by using the featured Hi/Lo pass filters, Resonance control, change the volume of each microphone by
using the related volume slider, flip the phase with the related button, link options for Distance, HPF, LPF controls and
set the mix of the 2 mics to find the perfect balance.

It is also worth noting that changing the microphone distance introduces a slight delay in the output signal, resulting in
phase cancellation that may help remove unwanted frequencies, so feel free to experiment.

Switch off the internal cabinet models by setting it to “Disconnected”. By doing so, the amplifier sound will pass
through the cabinet section unprocessed.

NOTE: You can bypass the cabinet section by clicking on the Cabinet icon in the footer controls while the Cabinet
view is open.

Notes on getting the most out of the Cabinet section:

- You can change the microphone distance and angle using the related knobs, however all 4 degrees of freedom are
conveniently accessible directly via the crosshair by using key modifiers: left-clicking your mouse and dragging will
move the microphone in the X/Y axis, left-clicking+ctrl and dragging will move the microphone on the Z axis, right-
clicking and dragging will angle the microphone.

- Each internal cabinet has its impedance curve connected to the amplifier power section, but in Tonality: Wes
Borland, you can use two different cabinets simultaneously. In this use case, the impedance seen by the power
amp will be the combination of the two impedances, so using the mix slider can help you achieve some very unique
tones.
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- In the internal cabinet menu, you can also find a “Disconnected” option. Setting the cabinet to “Disconnected” will
achieve the same result as connecting the amplifier to a purely resistive load, with the result of flattening the
poweramp in terms of frequency response and reducing the power amp controls (ex. Presence) excursion.

- Setting the cabinet as “Disconnected” is not the same as bypassing the cabinet section entirely! This is extremely
important to know when using Tonality: Wes Borland with external IRs. If you bypass the cabinet section, the
amplifier will keep seeing the load related to the selected cabinet(s) even if the cabinet and microphone are not
processing the signal. If you change the cabinet when the cabinet section is bypassed you’ll still notice some
differences in how the amp sounds and reacts, because you’re still changing the load connected to its poweramp.
For the most transparent poweramp sound when using external IRs, you should set the cabinet as “Disconnected”
and switch off the cabinet section. Feel free to experiment with various combinations to find some secret tones!
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Effects: Click to open the Effects view. Here you can engage and adjust all the controls of the modeled pedals.
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Borland Delay: Based on the Dunlop© Echoplex®© Delay, the Borland Delay emulates the legendary tones of the
EP-3 tape echo unit. There are three controls on the Borland Delay:

1.
2.
3.

SUSTAIN: Adjusts the number of repeats of the delay effect.
VOLUME: Adjusts the volume of the effect delay sound.

DELAY: Adjusts the delay time. Turning the control clockwise will lengthen the delay time.

WB7 Chorus/Flanger: Based on the Ibanez© CF7™ Chorus/Flanger, the WB7 Chorus/Flanger is capable of warm,
vintage choral tones to morphing flange sounds. There are six controls on the WB7 Chorus/Flanger:

1.

SPEED: Adjusts the speed (rate) of the chorus and flanger effect. Turning the control clockwise increases the rate
of the effect.

DEPTH: Adjust the effect amount of the chorus and flanger.
DELAY TIME: Adjusts the delay time. Turning the control clockwise will lengthen the effects delay time.

REGEN.: Adjusts the feedback amount. Turning the control clockwise increases the amount of feedback in the
output mix.

MODE: Switch between the Chorus and Flanger effect.

KRAZY: Switch between “Normal” and “Krazy” modes. Normal mode keeps the effects in a traditional stompbox
mode. Krazy is a unique feature that can push your tone into synth-like territory, allowing for the creation of
completely new and innovative sounds.
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Digital Delay WB-8: Inspired by the BOSS© DD-8™, the Digital Delay WB-8 replicates the delay modes used by
Wes Borland. There are four controls on the WB-8:

1. E.LEVEL: Adjusts the volume of the effect delay sound. Turning the control clockwise increases the amount of
delay sound in the output mix.

2. FEEDBACK: Adjusts the delay feedback, which is the amount of times the delay sound is repeated. Turning the
control clockwise increases the amount of feedback sound in the output mix.

3. TIME: Adjusts the delay time. Turning the control clockwise will lengthen the delay time.

4. MODE: Switch between the delay modes available.



MIDI Page 28

Standalone application

Audio/MIDI Settings * Open the standalone app and click on the Audio I/O
button.

« Select the MIDI inputs (device) connected to the
computer you want to use.
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+ Enable the MIDI Learn functionality by right-clicking on
one of the Tonality plugin model's learnable controls, a
popup menu will appear with two MIDI binding options:

MIDI Learn - Preset: This will store the MIDI bindings at
the Preset level. Preset-level bindings have priority over
Global Bindings, meaning that assigning a MIDI PC or
CC message at the preset level will override existing
bindings of the same messages at the Global level if
any. Preset-level bindings are saved within the active
preset and recalled when the preset becomes active.
Remember to save the preset using the Preset Manager
(check the Header Controls section) if you want to
persist the MIDI bindings.

MIDI Learn -Global: This feature will store the MIDI bindings globally for the application/plugin. Global bindings are
shared among presets, meaning the registered MIDI assignments will remain active even when changing presets
(unless overridden by a Preset level assignment as described above).

« Once you select the binding type, the application will notify you that it’s ready to perform the assignment. Press the
MIDI control you want to assign to the selected parameter/functionality on the MIDI controller and the binding will
be stored, making the MIDI Learn popup menu disappear. You can now adjust that plugin parameter value using
the connected MIDI controller.
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Using a MIDI message to change a preset

MIDI Settings

- If you want to recall a specific preset using your MIDI
controller, all you need to do is load the preset you want
to assign the MIDI message to, right-click on the preset
menu located in the left section of the header, and select
MIDI Learn - Global. This will trigger the previously
described MIDI Learn functionality and the provided
MIDI message will be bound to recall that preset. This is
very useful in a live-playing situation.

« The same can be done with the Previous/Next Preset
buttons placed on the sides of the preset menu if you
want to use your MIDI controller to switch from a preset
to the next or previous one without the need to reach
your computer. These types of bindings can only be
stored at the Learn Global level.

« All stored MIDI assignments can be reviewed and
modified in the MIDI settings panel, accessed by clicking
on the MIDI icon in the plugin’s footer section.
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Amp 1: Based on a Roland®© JC-120™ Jazz Chorus, this two-input channel with three-band EQ has become the
iconic “king of clean” guitar amplifier, with its flagship pure and transparent tonal signature.
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Amp 2: Based on a Diezel© VH4 ™, this four-channel 100W amplifier is extremely versatile, allowing virtually any
tone to be achieved with its four distinctly voiced preamps, each with independent gain, EQ, and master controls.
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Amp 3: Based on a 1965 model Selmer© Zodiac™ 50 MKII Tremolo, this two-channel amplifier offers the chime and
saturated breakup tones renowned with vintage UK combos however with the inclusion of the unique Selmer®© tone
selector system, this inventive circuitry gives this amp its distinctive complex tonal character.
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Resize: Click to resize the plugin interface. There are three possible values available: 50%, 75%, and 100%. In
addition to these 3 modes, you can fine-tune the size using the resize function in the bottom right corner.

Presets: The preset manager is divided into 3 sections:

- Load: In the Load section you’ll find all the available
banks where each bank entry has a submenu featuring
all the presets it contains.

- Create: Under the Create section, you can either add a
preset to the current bank or create a new bank entirely.
When creating a new bank, the currently loaded preset
will be copied into it, you can tweak it later using the edit
options.

- Edit: Under the Edit section, you can save changes to
the current preset or bank file you are working on.
NOTE: If you want to copy settings from one instance to
another track in a DAW project, you can use the Edit >
Current Preset > Copy function.
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PRESETS TEMPO (BPM) ROUTING v0.1.1 ARM64
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Tempo (BPM): Set the desired tempo for the plugin (Standalone mode only). NOTE: Tempo is saved at the preset
level.

Routing: Tonality: Wes Borland supports three different routing modes: Mono, Mono/Stereo, and Stereo.
- Mono: All the plugin sections will process the signal in mono.

- Mono/Stereo: All the plugin sections will process the signal in mono mode until an element supporting the “Mono-
To-Stereo-Split” is encountered. When this happens, the signal is split and the remaining elements in the chain will
automatically switch to stereo processing. Delay and reverbs are typical models supporting the “Mono-To-Stereo-
Split”, so when using those pedals in Mono/Stereo routing mode, the signal will be split and the subsequent effects
will work in stereo mode until the signal reaches the output.

- Stereo: All the plugin sections are internally doubled and will process the signal in stereo (left + right).

- Routing Lock: Click the lock icon in the current routing mode to audition different presets that maintain the routing
untouched and avoid overrides. Since the routing mode is saved in the preset itself, loading a Preset will change it.

NOTE: In the plugin versions of Tonality: Wes Borland, if the Routing menu only features the “Mono” option you’ve
most likely loaded it into a mono track. Use a stereo track if you want to enable the other routing options. Tonality:
Wes Borland (standalone only) if the routing menu only features the “Mono” option, please check the setup in the
output in the Audio I/0 settings. Enable at least two outputs from the Audio I/O menu, close the application, and re-
open it. You should now see all the routing options available.



Support Page 36

For technical issues or any problems experienced with our software contact us via the contact page at
www.stltones.com.

Before doing so, follow our troubleshooting questions below to see if these fix your issue:

Support Information to be provided

- To help us assist you in the best way possible, please provide the following information to our support team:
« Product Version Number (e.g. Tonality: Wes Borland v1.0.0)

- Version number of your DAW (e.g ProTools 2021.12.0)

- Interface/hardware (e.g. Focusrite Scarlett 2i2, Universal Audio Apollo Twin, etc.)

- Computer and operating system info (e.g. Macbook Pro OS X 11.5.1, Windows 10 ver 1709, etc.)

- Please include a detailed description of your problem.
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Uninstall / Reinstall

This will repair possible broken permissions, fix corrupted files, and remove old versions of our software

Steps:

1. Close out of all host software (Pro Tools, Logic, Cubase, etc.)

2. Uninstall your plugin.

3. Open your host software and ensure that the plugins no longer showing up in the inserts list. If the plugins are still
present, locate the files on your computer and remove them manually. Once they no longer show up in your DAW
(after restarting it), move on to step 4.

4. Close out of all host software.

5. Follow the installation and licensing procedure outlined in the “Installation & License Activation” section of this
manual making sure you have the latest installers for the plugin.

6. Run the latest installers and start your host program.

7. Follow the STL licensing prompts, ensuring that your host program is reading the latest version of our software.
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Repair permissions on your computer
Instructions: Run your host software as an administrator (Windows-only)

This can fix a variety of issues that result in crashing or error messages on Windows DAWSs that are loading our
plugins for the first time.

1. Exit your host program (Pro Tools, Cubase, etc.)

2. Right-click on the icon for that host program and select “Run as an Administrator.” You will only have to do this
once, meaning you can open up the host program normally the next time.
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How do | find my plugin in Reaper?
If you cannot find your STL Tonality: Wes Borland plugin in Reaper, follow these steps to make the plugin available:

1. Follow the installation and licensing procedure outlined in the “Installation & License Activation” section of this
manual, ensuring you have the latest installers for the plugin.

2. Now check if the plugin is installed on your computer in the default folder.

File Locations: Mac
VST: Macintosh HD/Library/Audio/Plugins/VST/STL Tonality - Wes Borland

File Locations: Windows
64-bit VST: C:\Program Files\VSTPIlugins\STL Tonality - Wes Borland

If you don’t find the respective files please reinstall your STL Tonality: Wes Borland Product. If the relevant plugin files
are in the above folder, perform a rescan:

1. In Reaper, press [Ctrl] + P (Windows) / [Cmd] + [,] (Mac) to access Preferences.
2. Goto Plugins > VST

3. Under “VST Plugin Path,” make sure that the following path is listed (if not, add it):
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Windows: 64-bit VST: C:\ Program Files \ VSTPIlugins \ STL Tonality - Wes Borland
Mac: System HD > Library > Audio > Plugins > VST
Click on Clear Cache/Re-Scan. Create a new session with a supported sample rate, add a track, and load your STL

Tonality: Wes Borland plugin. If the pop-up window tells you to activate please press follow the installation and
licensing procedure outlined in the “Installation & License Activation” section of this manual.
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How do | find my plugin in Pro Tools?
If you cannot find your STL Tonality: Wes Borland plugin in Pro Tools, follow these steps to make the plugin available.

1. Follow the installation and licensing procedure outlined in the “Installation & License Activation” section of this
manual, ensuring you have the latest installers for the plugin.

2. Now check if the plugin is installed on your computer in the default folder.
VST: Macintosh HD / Library / Audio / Plugins / VST / STL Tonality - Wes Borland
AAX: Macintosh HD / Library / Application Support / Avid / Audio / Plugins /STL Tonality - Wes Borland

Windows: 64-bit VST: C:\Program Files\VSTPIugins\STL Tonality - Wes Borland
Windows: 64-bit AAX: C:\Program Files\Common\Files\Avid\Audio\Plugins\STL Tonality - Wes Borland

If you don’t find the respective files please reinstall your STL Tonality - Wes Borland Product. If the relevant plugin
files are in the above folder, perform a rescan:

1. To do a Rescan, you must delete certain files on your computer depending on your Pro Tools version. Please
follow the official Avid website to do this.
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The plugin makes no sound at all, why is this happening?

You have most likely not activated the software yet, or the license file has moved to a different location and the
software can't find it anymore. Follow the installation and licensing procedure outlined in the “Installation & License
Activation” section of this manual, making sure you have the latest installers for the plugin.

Where do | find the installers?

Visit https://www.stltones.com/pages/file-downloads where you will find the latest installers for your product.

Where is the STL Tonality Plugin located on my computer?

Mac:

AudioUnits: Macintosh HD / Library / Audio / Plugins / Components / STL Tonality - Wes Borland

VST: Macintosh HD / Library / Audio / Plugins / VST / STL Tonality - Wes Borland

AAX: Macintosh HD / Library / Application Support / Avid / Audio / Plugins / STL Tonality - Wes Borland
Windows:

64-bit VST: C:\ Program Files \ VSTPIlugins \ STL Tonality - Wes Borland

64-bit AAX: C:\ Program Files \ Common Files \ Avid \ Audio \ Plugins \ STL Tonality - Wes Borland


https://www.stltones.com/pages/file-downloads
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Plugin Development: Federico Berti (Ignite Amps)

Plugin GUI: Sonny Truelove and Dan Dankmeyer

Need more help?
Find technical support and instructions here: www.stltones.com/pages/contact-us

Contact our friendly Support Team here: www.stltones.com/pages/submit-a-request

Sincerely,

STL Tones Team



